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What is Falcon? 
Falcon is a Content Management Service, which creates individual websites in a managed 
environment, ready templated in the University house style and with a range of functionality 
already available. Falcon is based on the open source content management system Plone 
(http://plone.org/). 

This course covers the new University templates which have just been introduced in a new version 
of Falcon. The new templates are responsive, which is to say that they adapt to give a slightly 
different presentation for tablet and mobile devices. Some of the functionality has been changed – 
although the basics of how Falcon functions remain the same as in the old templates. 

What this course does 
This course is to introduce you to what Falcon can do and how you can use that functionality to 
create a website. It is a practical-based course, during which you build up some content on a course 
website. Some of you may be sharing a course website – partners ought to sit next to each other as 
you will need to do some of the practicals together. Although don’t need any knowledge of HTML to 
use Falcon, you will find it easier to troubleshoot pages if you do. There are two introductory 
courses run by UCS (see 
http://training.csx.cam.ac.uk/search?type=all&query=Web+Authoring&_action_search=Search&_pas
tEvents=&pastEvents=on) that will give you enough background to be comfortable. 

On day one, the course covers the following: 

• An overview of Falcon 

• A look at the default site 

• Learning to add simple content 

• Configuring your site’s look and feel 

• Adding news, events and jobs 

• Working with portlets and your home page 

You can see that although you will be raring to get to your home page, we don’t get to that until 
you’ve been through the basics of how your site works. 

On day two: 

• Recap of work so far 

• Setting the site footer 

• Adding more complex content to pages 

• Adding other content to your site – a research directory, discussion forums and forms  

• Adding users and groups, and restricting access to content 

• What metadata is and how to add it 

• Looking at the ‘back end’ of Falcon 

• Other admin functions 
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1. Introduction 
What can Falcon do? 
• Allow a certain amount of configuration of the site and ability to manage users and groups 

and their access to the site and for updating pages 

• Work within the standard University templates so that breadcrumbs are generated 
automatically, left-hand navigation is constructed, etc. 

• Serve standard web pages with images, pdfs and Word documents - the web pages are edited 
through the web browser and the images, pdfs and other documents are uploaded individually 
through the web browser. 

• Give access to in-built added functionality 

• Solve website delivery problems for £100 per year. 

ACCESS TO IN-BUILT ADDED FUNCTIONALITY 

There are various additions to help you manage the site and its content: 

• You can add pre-configured items (feeds/static text/link lists) in right panel of any page and 
on main area of home page of site - these are known as portlets 

• There is in-built management of news, events and jobs - all of these produce rss feeds and 
may be added to the right panel of pages 

• You can configure footer information for the whole site and at a folder-by-folder level 

• You can add a person-based directory (initially called Research Directory) in which people are 
cross linked with categories (initially Research Themes) and could be linked with groups 
(initially called Institutions or Departments). People can also be linked to committees and 
collaborators. 

• You can manage other functionality (see below) 

MANAGING OTHER FUNCTIONALITY 

There are various other additions to help you manage the site and its content: 

• A form generator. Once you have created a basic form folder, there is a long list of additional 
functions you can add. 

• A message board. 

• Metadata for pages - on each page the editing bar has a tab 'seo properties', which lets you 
add metadata for the page. 

• Keywords within the people directory can be managed so that similar keywords added by 
different people can be selected and merged into the same term. 

• Google analytics code can be added into the Site Setup 

• Redirections and aliases can be set up. 

• Falcon sites can be registered with the UK Federation to be Shibboleth-authenticated - 
people can obtain third-party Shibboleth identities if need be. 

WHAT FALCON WON'T DO 

• A site with something other than the University templates 

• Allow interaction with other server technologies 

• Allow admins access for further customisation 



25 & 26 February 2013  3 

Requesting a Falcon site  
When you request a Falcon site, there will be a short list of information we need. 

• The crsids of the admins of the site 

• The purpose of the site and the department under whose aegis it comes 

• A domain name for the site (not required initially, but needed before the site can be made 
live) 

• A role-based email address for contact purposes (again, not required initially, but needed 
before the site can be made live) 

Send this information in an email to falcon-support@ucs.cam.ac.uk. Sites are usually set up 
overnight and will be ready for you to use the next day. 

Making your Falcon site 'live'  
During the development phase the site is accessed via a url of the form http://www-
falcon.csx.cam.ac.uk/site/NAME (which blocked from being indexed by Google) - when the site is 
'made live' a domain name (such as http://www-name.eng.cam.ac.uk) is associated with this name. 
The domain name is supplied either: 

• by the department within which the site is based (who manage their domain names 
themselves) 

• by a request to Institution Strategy (institution-strategy@ucs.cam.ac.uk), who agree 
cam.ac.uk and group.cam.ac.uk domain names and can supply appropriate other advice about 
names 

Once the name has been agreed the UCS needs to apply for and apply a security certificate for the 
site (which can take 24-hours and more), and then the DNS needs to be updated to make the 
domain name live (which will happen overnight). If you have a date in mind, it is best to send your 
request to falcon-support@ucs.cam.ac.uk a week or so ahead of time so that this preparatory work 
can be done. 

We can only apply cam.ac.uk names to Falcon sites. 

Removing a Falcon site 
If you decide that Falcon isn’t for you, just email falcon-support@ucs.cam.ac.uk and ask for the site 
to be removed. 

What do you want in your website? 
Another thing Falcon won’t do is design your site structure for you - you will still have to consider 
how to design the site to make the most of how Falcon works. Your website needs to work for the 
users you anticipate visiting it, and provide them with the information you anticipate they need, so: 

• Decide on the broad objectives of your site 

• List the user groups that will be using your site 

• List the categories of information you wish to present 

• Look at the list of features available in Falcon and decide which of them you want to use 

• Think about how you are going to keep your site up to date. Who are you going to give ‘edit’ 
access, and to what parts of the site? 

• Draw a up a tree diagram of what you want on the site, with the home page at the top, 
labeling the folders, sub-folders and pages, to get something like this: 
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You then use this map of your site as a framework for adding folders and pages to your site. 

Recommended reading: Yale Web Style Guide (3rd edition) – ‘Information Architecture’ 
http://www.webstyleguide.com/wsg3/3-information-architecture/ 

How do you want your site to look? 
There are two elements to the look of the site: 

• the structure and presentation of the information 

• the appearance of the page, in terms of colour; how many images you want; what is in the 
head and foot areas; what search you want to use. 

Falcon by default has a site-wide navigation bar to which all new items in the top level of the site 
are added, and the contents of folders are exposed as pop-down navigation (except for ‘News and 
‘Events’). You need to use your navigation bar wisely: 

• add to it the main sections of the site that you want people to be able to access easily from 
any page 

• be careful not to use long titles for those sections 

• don’t add too many individual items to a folder forming one of these sections, otherwise the 
pop-down is unwieldy  

The mechanics of the publishing process 
Falcon manages content in a staged process (known as the workflow). 
When a user of any kind creates content and saves it, the content is 
‘private’ and cannot be seen by browsers of the site. The content does 
not become visible to all until it is published. Once content is 
published by an admin user, it can be withdrawn to be ‘private’ again 
by being ‘retracted’. This whole process can be accomplished 
manually or can be scheduled. As a visual aid, ‘private’ is flagged in 
bright red type and ‘published’ content is flagged in blue type. For 
site members who can’t publish directly there is an interim step 
(‘pending review’) for approval by an administrator, who can also 
‘send back’ content if it isn’t right for publication. The most common 
reason for content not being available to users (or causing a request 
for Raven authentication) is because it has not been published. 

If an entire site is set up to be ‘Cambridge only’ accessible, the workflow changes. More 
explanation of this is available on demand. 

When you are working on a site, you are Raven authenticated and your view will be the 
authenticated user’s view, so you will see the editing bar and your private content. If you are one 
of the site admins (known as managers), you will see this throughout the site. If you only have 
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editing rights for certain folders, after you have authenticated you will see the editing bar only on 
those folders. To have a proper non-authenticated user’s view, you will need to run a second 
browser that is not Raven authenticated (make sure you use http://… rather than https://… 
otherwise you will be prompted to Raven authenticate). 

2. A look at the default site 
The default site 
When a new Falcon site is created it looks like this: 

 

When logged in it looks like this: 

 

There are default folders set up for you, which you can see across the navigation bar, or if you click 
on the contents tab you can see the full contents of the site: 
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In this contents view you can see the contents of a typical default set up, with a range of different 
icons, which represent different types of content: 

• a folder  

• a page  

• a collection  

• a script  

Don’t delete anything from your site – you: 

• probably don’t know what it is 

• might not want it now but you could need it in future 

• can just make it not visible.  

Comparing the navigation bar and the contents view, you can see there are items in the contents 
view that are not on the navigation bar – they have been excluded from the navigation bar (for 
which, see a bit later).  

HOW TO PUBLISH CONTENT 

When you create some content, there will be a ‘state’ shown on the editing bar, which will show 
that the item is private. This is shown in red so it is more noticeable: 

This is what you’ll see: 

 

When you click on ‘state: private’, you’ll see a pop-down: 
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When you select ‘publish’ from this, the state of the page will change: 

 

If you want to unpublish or retract the page, go to the pop-down again and select retract: 

 

If you go to the ‘content’ tab on the editing bar of the folder, you will see that an unpublished page 
or folder will be listed in red: 

 

If you check the box by the side of the filename and click on ‘change state’, you will be able to 
publish the page (you can select several items at once – if you select a folder a check box on the 
second screen makes it possible to select all items in the folder, as here): 
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HOW TO EXCLUDE ITEMS FROM THE NAVIGATION BAR 

By default, when you add a folder or file at the top-level of your site it will included in the 
navigation bar and will be seen by all users once it is published. Clearly all items shouldn’t be in the 
navigation bar – you can exclude them in one of two ways;  

• by changing the settings of the folder or file to remove them from navigation 

• by not publishing the content (or retracting it from being published).  

The two ways both have their uses –: 

• the first is right if you don’t intend the item ever to be in the navigation bar or you want to 
keep in mind how the site looks to users 

• the second is right if you do intend the item to be in the navigation bar eventually, but while 
working on the new content you will have to also keep a ‘user’s eye’ on the site with an 
unauthenticated browser. 

Changing settings: If you want to exclude, say, the Research Directory from the navigation bar, do 
the following: 

• Click on the folder or the navigation bar link to open the folder. 

• Click on the ‘edit’ tab in the editing bar 

• Click on the ‘Settings’ tab on the editing screen 

• Check the box next to ‘Exclude from navigation’ and save. You will see the item disappear 
from the navigation bar. 

 

Reverse the process to get items back into the navigation bar. 

Retracting published content: If you want to keep a standard item (say, the Research Directory) in 
the navigation bar for your own ease of use, but you don’t want it to be seen by others while you 
are developing it, you can retract it from publication so that it is private to you. You can do this for 
the folder and its contents via the contents screen: select the folder and then click 'change state' 
at the bottom of the content table. 

The screen you now see will give you the opportunity to 

• include the contents of the folder (by check box) 

• Set a time and date for publishing 

• Retract the item (if the item wasn’t already published you would be able to publish it or 
submit for publication). ‘Send back’ is used for refusing an item submitted for publication. 
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The example below shows the setting for publishing a folder and its contents: 

 

 

2. Learning to add simple content 
The framework for adding simple content in Falcon is adding folders that contain pages and 
(possibly) files and/or sub-folders. The pages can contain standard html content, including images 
and embedded video or iframes. If you have no experience of html, it would be useful to learn 
some, either by doing a course or some tutorials such as those at http://htmldog.com/ For those 
with some experience of managing content manually, there is a slight difference in the concept of a 
folder in managed content, since unlike in a standard filesystem it has an entity and appearance, 
even though it contains nothing. 

You add new folders, files and pages via the editing bar: 

 

Adding a folder 
• If you have a new site, go to the home page to add a folder at the top level of the site. 

• Click on the 'add new' tab on the editing bar and select 'folder' from the pop-down list 

• Name the folder (both the short name and the title). The short name is what will appear in 
the url – we recommended lower case, although it can be mixed case. The title should not be 
too long, especially if you wish this folder to feature in the navigation bar. 
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• You are then taken to the folder, and if you are ready, you should publish it (select the right-
hand 'state' tab and choose 'publish' from the pop-down). If you wish to assemble the content 
in full or have someone else check it before publishing it, you can publish the folder and 
contents later. 

If you add a page or a folder at the top level of the site, you will see that the folder has by default 
been added to the navigation bar. 

NB: Once you have added a folder and saved it, your location will be within that folder.  

Adding pages 
• Click on the 'add new' tab on the editing bar and select 'page' from the pop-down list: 

• Name the page (both the short name and the title). The short name will appear in the url (it 
shouldn’t have the .html suffix) and the title will be both the title (which appears at the top 
of your browser window) and the h1 heading of the page. If you want to add the content now 
you can, otherwise you can come back to do that once you have a set of pages ready to 
populate. Save the page. 

• You then see the created item, and if you are ready, you could publish it (select the right-
hand 'state' tab and choose 'publish' from the pop-down). If you wish to assemble the content 
in full or have someone else check it before publishing it, you can publish a folder and 
contents later. 

When you add a page to a folder, you will see that the page has by default been added to the left-
hand navigation.  

Adding files 
Often people want to have pdf files in a folder. To add pdf files, choose ‘add new…’ > file from the 
editing bar. If you have many pdf files to add, you can do a bulk upload (see later).  

When you add a pdf or any other sort of file to a folder, you will see that it has by default been 
added to the left-hand navigation. Unless you want them all to be seen in this way, it may be 
sensible to put them into a sub-folder and exclude that sub-folder from the left navigation. 

REMOVING FILES FROM LEFT-HAND NAVIGATION 

A folder, file or page can be removed from the navigation if required, in a similar way to removing 
items from the navigation bar – to do so: 

• Click on it, so you are in or on the item, then select 'edit' from the editing bar: 

• Then select 'Settings' from the bar at the top of the editing screen: 

• Then, from the choices on the screen, select 'Exclude from navigation' and click 'save'. 

• The entry with the page title will disappear from the left-hand navigation. 

Adding sub-folders 
If you want a second level of navigation in a folder of content, you can add a folder, and then add 
pages to that folder. The pages will be shown as second level navigation items once the folder is 
selected (see http://falcon-help.csx.cam.ac.uk/site-setup/adding-users as an example). Further 
levels of navigation are created when you add another sub folder. 

PRACTICAL 1:  

• At the top level of your site, create a folder with the title Information about widgets, with 
the short name widget-info. [If you are working in a pair you will have to use, one partner should 
use More information about widgets, with the short name more-widget-info.]  

• Create three pages in the folder, with the titles: Widgets introduction, Widgets for 
students and Widgets for staff – make suitable short names – save them without adding any further 
content.  

Adding content 
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Within a page there is a built-in wysiwyg editor that allows you to type your content directly and 
style it, or switch into looking at the html. The editor is called TinyMCE, and it is used on a 
widespread basis in through-the-web editing. Like any embedded editor, it can take your styling 
commands rather literally, producing a nest of html. The available buttons on the editor are labeled 
so are self explanatory. If the appearance of your page is odd and you have experience of html, it is 
worth looking at the code to see if extra code is being added that you are not aware of. (There are 
more details about using the editor at http://falcon-help.csx.cam.ac.uk/content/editor) 

• If you are typing directly into the editor, it’ll probably cause fewer coding glitches to type 
the text in first and then add the styling (or functionality) afterwards by selecting the text 
and then selecting either the style from the pop-down menu or the editor buttons. 

• If you have existing html, turn to html mode  and paste the content fragment of the 
html directly into the page and update then save it. You will have to transfer any images and 
re-insert them, and also re-create any internal links, and will have to check that tables are 
styled properly (using the ‘standard’ style) but otherwise the page should look OK. The 
system will quietly remove forbidden code, like javascript or inline styling (more later about 
this). 

• Copy and paste from a document or browser window into the edit screen. This process might 
bring some formatting along with it, which you will need to clean up. Use ‘Paste as text’ or 
‘Paste as Word’ buttons to remove all or some of the formatting when pasting into Falcon. 

Adding links 
There are two kinds of link – internal links, that is those to items within Falcon, and external links, 
going outside Falcon.  

• To add either, you first create and select the link text and click on . You will see a 
screen similar to this: 

 

To insert an internal link you navigate to the item you want to link to and click ‘insert’. To add an 
external link, click on the ‘External’ tab and you will see the following: 
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Here you can add the URL you want. You will see a pop-down that allows you to style the link to 
open other than in the current window: 

 

You shouldn’t open links in new windows without warning the user on the original page. 

Adding images 
By default there is a folder for images at the top level of your Falcon site. It is usually good practice 
to keep your images together in one place so that you can easily find them and re-use them if 
necessary. There is no requirement to do this, and if it is easier for your circumstances to keep 
images in folders throughout the site this is fine – do not name all the folders ‘images’, as Falcon 
can get confused. Falcon will allow you to upload a wide variety of image types but only .gif, .jpg 
and .png will be shown on web pages. To show, for instance, a .tiff file on a web page, you will 
have to convert it before uploading. Make sure you optimize your files to a sensible size before you 
upload them, both in terms of dimensions and dpi – images for viewing in web pages ought to be 
72dpi. Standard image sizes for the new templates are: 

• For the home page: carousel/large image - 885 x 432px; teaser image - 250px square, so 
currently used square images may be usable 

• For carousel/smaller image at top of second level pages: 590 x 288px 

• For images within pages: they should be 250px square, so currently used square images may 
be usable 

• For teaser portlet: 349 x 125px 

It is wise to name your image so you know what you intended it for, for instance either size of 
carousel images and the teaser portlet images are particular sizes and couldn’t be used as a 
standard image in the content area of a page. 

You can upload images as a group or you can upload them individually when you wish to add them 
to a page - the method is slightly different, as shown below. Adding images to profiles in the 
Research Directory follows a different method and the images are kept in the directory, as detailed 
later. 
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Uploading an image to the image directory 
• At the 'home' level of your site, go to the 'contents' tab on the editing bar and click on 

'Images'. 

• Go to the 'add new...' tab on the editing bar and select 'image': 

 

The only requirement is to browse to the image you wish to upload from your local machine and 
select it.  

• If you add a short name it will be used in the url for that item (otherwise the uploaded file's 
name will be used, although any separators in the filename might be removed);  

• if you add a title, it will be used when the image is listed in the images folder and will be also 
used as the alt text for the image;  

• if you add a description, it will be used when the image is listed in the images folder.  

You can edit these fields after the upload if you wish. 

ADDING A BULK UPLOAD TOOL TO YOUR IMAGES FOLDER 

When you add more than one image, you will find it easier if you have a bulk upload tool available. 

In the images folder: 

• Click on ‘Manage portlets’ link 

• Go to ‘Add portlet…’ on the right side of the screen and select Quick Upload Portlet. You 
don’t need to add or change anything to the screen that comes up, but you do need to save. 
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The upload portlet will now appear on the right side in your images folder, like this: 

 

You can use it to select several files for upload in a batch. 

PRACTICAL 2 

• Navigate to your Images folder. Using the ‘view’ tab on the editing bar, click on the link 
‘Manage portlets’ in the content area. Go to the ‘Add portlet’ drop down on the top right and select 
‘Quick Upload Portlet’ – accept the default settings by saving. Click back on ‘Images’ in the 
breadcrumb trail. You will now see the portlet on the right side of the images folder that allows you 
to upload multiple files or images. 

 

Adding an image to the content area of a page 
While you are adding content to a page (or afterwards) you can upload and add images within the 
content in a single process.  

TO ADD AN IMAGE TO A PAGE: 

If you want to float an image right or left, you need to insert it at the start of a paragraph 
immediately before the first letter. If you want an image to be on a line by itself, create that new 
line and insert the image at the start of it. Position your cursor and select the 'insert/edit image' 

icon  in the text editing bar.  

You will see the Insert/edit image screen: 
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This gives you the opportunity to select or upload an image in the folder that you are currently in.  

• If you wish to upload an image to the folder /Images/ you will need to navigate to 'home' and 
then 'images', then select 'upload file'.  

• If you wish to upload an image in the folder you are currently in, you should just select 
'upload’ then Upload file functionality will appear on the right of the panel. 

. 

You will then need to browse to the image on your local machine and select the one you wish to 
use, add a title for it and a description if you wish (see above for what these are used for). Click OK 
and then Upload. The images list in the middle column will now contain the image you just 
uploaded, and it will be selected. 
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On the right you will see the image and the options for adding the image into your page. You can 
select  

• add a description (if you hadn’t already), which will be used as a caption if you choose that 
option. 

• how you want to position the image 

• a size selection if you don’t want to use the image at the size you originally used (your image 
will be scaled so the largest dimension fits the size you choose). The 200px square option is 
suitable for use in images added to text. 

Finally click ’Insert’. Your page (still in editing mode) will now show the image you have added. If 
you have added a caption, you won’t be able to see it until after you have saved the page. 

If the image is not how you want it, you can select the image and go back to ‘Insert/edit image’, 
change the settings you chose, then click ‘Update’. If the image is not where you want it, it may be 
easiest to go to the HTML view in the text editing bar and move the image. 

Uploaded images are automatically published. If you create a new folder for the images you will 
have to publish the folder otherwise the images won’t be visible to users who are not logged in – 
you will also want to modify the settings so that it doesn’t get featured in the left hand navigation.. 
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PRACTICAL 3: 

• Create a new browser tab for https://falcon-help.csx.cam.ac.uk/course-materials/, go to 
‘Information about widgets’ and you will see copies of the three pages you started. Go to ‘Widgets 
introduction’, and copy the text from the web page. Go to your equivalent page and paste in the 
text. Look at the HTML view of the page. You may see some extra code that has been added during 
the copy-and-paste process, which you can remove if you like. .  

 This formatting has been collected in the copy-and-paste process but doesn’t affect the 
look of the page. You could delete it if you want. Save the page. Do the same thing for the ‘Widgets 
for staff’ page, so you now have two pages with content in them. 

• In your pages, open ‘Widgets for students’. Open another tab on your browser and go to 
the page http://en.wikipedia.org/wiki/Widget_(beer) – select and copy some of the text and paste 
it into your page. Look at the html view and see the result.  

• Open one of your pages and select ‘edit’ tab. Select a place at the start of the text and 
insert the image you will find in your /Images/ folder (following the instructions above), positioning 
the image on the right. 

• Upload some images or files into the Images folder from your USB stick, using the Quick 
Upload tool. Now go back to one of the widget pages and insert one of the images you just 
uploaded. 

Sorting our how your folder looks 
Having added some pages to your folder, we now have to sort out how it looks. 

In a standard Apache web server, when there is a request for a folder the default page for display is 
usually a page called index.html. In Falcon you get to choose which page is displayed as the default 
page when a folder is requested, which you will then see instead of seeing the pages listed in the 
content area like this: 

 

The page you elect to become the default page is now shown in the left-hand navigation when the 
folder name is selected. It also appears in the navigation popdown as the overview for the folder. 

TO MAKE A DEFAULT PAGE  

• First create your introductory page 

• At the top level of your folder, in the edit bar go to ‘display’ and select ‘select a content 
item as default view…’ then select the page you have created for the introduction. 

• If you go to the contents view of the folder, the default page will now be shown in bold. 

• Now when you go to the top level of a folder and select ‘edit’, at the top of the editing 
screen you will see the following: 
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Reordering the left-hand navigation 
When you add pages or files to a folder, they will be added to the left hand navigation in the order 
that you add them. When you want to change the order, navigate to the top level of the folder and 
go to the content tab on the editing bar - you will then see a table listing the content of the folder, 
and down the left side of the table there is an icon made up of dots which you click and drag then 
release to move items up and down. When you click and drag the line turns yellow: 

 

You will not see the changed order in the left hand navigation until you go back in ‘view’ in the 
editing bar. 

PRACTICAL 4: 

• Go to your widgets folder, create a new introductory page and use it as the default page for 
the folder. 

• Go to the contents tab and move your left-hand navigation items up and down the list. You 
will need to go to the view tab to see the change. 

• First you need to move a pdf file into your folder. Go to the home page of your site and to 
the contents tab. Click the check box by the side of the file ’Widget (beer) - Wikipedia.pdf‘. [If 
you are working in a pair, start by clicking on copy and then paste to generate a second copy of the 
file.] After that, select the file, click on cut, move into the contents tab of your widgets folder and 
click on paste. Look in the ‘view’ tab. The file will not appear in the left navigation. 

• Go to the content tab, click on the pdf file, and click the ‘rename’ tab. Give the file a 
suitable short name and title.. 

• Go to one of your widget pages and click the ‘edit’ tab. At the bottom of the page insert a 

link to your pdf file (type some link text, select it, then click on ‘insert/edit link’  and locate 
pdf file) – you can copy the title of the pdf and use it to replace the link text. 

4. Configuring your site’s look and feel 
When your site is initially set up you are asked for some information about site name, 
administrators and a contact email for the site, which is recorded in the registration database. This 
will be setup within the site configuration and will be used behind the scenes. Other aspects of the 
site configuration can be changed. 

• Go the 'Site setup' (in the popdown below the site login tab): 

 

• Go to Plone configuration > Site, which shows you a few possible site-wide settings 
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• This is where you change the site title that appears at the top of every page. 

• ’Expose Dublin Core metadata’ is already checked. Leave the other options as they are for 
now – they may be enabled if you wish and when you have sufficient skills to know how to use 
them (adding Google Analytics code is particularly useful – see https://falcon-
help.csx.cam.ac.uk/site-setup/google-analytics). 

• If you have made any changes, save them 

There are options that you can set which alter how your site looks and works. To access these 
options: 

• Go the 'Site setup' (in the popdown below the site login tab, shown above) 

• Go to 'Add-on Product Configuration' > Site Customisation, which shows you some possible 
site-wide options. Here you can  

 • Add an optional second line for your department or site title if you need one 

 • Add a favicon and/or a logo, if you want to. The favicon appears in the top bar of a 
browser, and in bookmarks of newer browsers. The The logo will appear in the header 
and to the left of the site title. For both you must upload the image first and then 
browse to it in the site customization screen.  

 • Select a colour scheme from the list that are available  

 • Use University search engine allows you to select options for how your site search 
works.  

  • If the box is not checked the default Plone site search is used but your site will still 
be searched by the University site-wide search (although you ought to tell us about your 
server to ensure this happen straight away). 

  • Add your Institution ID and a search filter if you want to use one (a search filter 
covers a number of web servers but is expressed as a single expression - if you want one 
see http://www.ucs.cam.ac.uk/web-search/searchforms).  

PRACTICAL 5:  

• Working with your partner, if you have one, configure the appearance of your site to your 
choice. 

• Working individually, go to your widgets folder and add a footer with links. If you prefer you 
could change the site footer at the top level, either working as a pair or individually. 

5. Adding news, events and jobs 
News, events and jobs are similar special forms of content for which the information you add about 
each item is pre-ordained, and then all items of the same item type and collected together in a list. 
The collection into a list is related to the item type, and you can set this up yourself (of which more 
later). Within each of the default folders, if you look under the contents tab you will find a file. 
This is the collection file that causes any new, events, or jobs item to be collected and formed into 
a date-order list. Do not delete this file or the date order of your items will be lost.  

Adding items for any of these special types of content works in a similar way. Once you are in the 
appropriate folder, going to the 'edit' tab and selecting add new will give you a pop-down selection 
that only consists of a new item for that information type - news item, event or job. There is a 
large amount of detail that you can add in each case - if you don't add information in fields then the 
empty fields will not appear on the published page. When you have saved the item, it won't be 
visible until you publish it. To do this, select the right-hand 'state' tab and choose 'publish' from the 
pop-down. If you wish to assemble the content in full before publishing it, you can publish the 
folder and contents later. 

As with the publishing process in general within Falcon, you can choose to publish at a particular 
time and date and retract the item at a given date and time. 
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It may sound obvious, but it is important to distinguish between ‘news’ and ‘events’ items. Events 
are associated with a time and a date (and also a place) and gain a direct link to a calendar, 
whereas news events do not have these connections. 

PRACTICAL 6: 

• Start by looking at your home page. If you are working with a partner, one of you add news 
and the other events. 

• From ‘Home’ go to the ‘News’ tab. In the editing bar go the ‘add new…’ > news item and 
fill in information to create a news item, save and publish it, then step back up to the news folder 
and create a second one. 

• From ‘Home’ go to the ‘Events’ tab. In the editing bar go the ‘add new…’ > event and fill 
in information to create an item, save and publish it, then step back up to the events folder and 
create a second one. Make sure both events are taking place this month. 

• Now look at your home page again and note the changes 

6. Working with portlets 
More about portlets 
Portlets are modules that allow extra (often dynamic) information to be added to any page, adding 
the formatting while you add the content. For instance, rss files to be displayed, several rss files to 
be collected together and displayed, a calendar, a list of links or a box of static material, an upload 
tool, etc. (You have already added an upload portlet to the images folder, so have had some 
contact with them.) When you have published a news, events or jobs item, if you have the news, 
events and/or jobs portlets set to appear on pages, then they will become live with links to the 
details (news and events portlets are on your pages by default). These portlets appear because the 
streams of information generate an rss feed, so you could then direct other sites to these rss feeds 
(the link appears when you hover over the rss icon). If you are showing a calendar in your portlets, 
the events will also become a link in the calendar. 

In Falcon there are a range of different portlets. Some can be added only in specific locations: 

• most can be added on the right side of any page 

• all can be added either to the content area or to right side of the home page 

• an image/carousel can be added to the content area of a second-level folder 

* the site footer is a special kind of portlet, which is added site-wide through the home page, 
but can be modified on folders in the site 

The portlets shown on the right side of the home page will be inherited through all folders and 
pages unless this inheritance is blocked, and different portlets (or none) may be show on any page. 
Different portlets can be added even when portlets are being inherited, but inheriting portlets is an 
on/off function - if you want to keep only one of a group, you will need to block them all and 
manually add back the one you want to keep. 

Managing portlets on the home page 
The home page for your falcon site is already for you to edit or assemble. If at the top level of your 
site you look at the ‘Display’ tab in the editing bar, you will see that there are two options: 

 

Leave the display settings as they are. You can use the ‘Edit’ tab in the normal way to add content 
to the page. If you access the ‘Manage portlets’ link, you see these options available: 



25 & 26 February 2013  21 

 

 

This display option allows you to add a large image (or several to make a carousel), which will 
appear at the top of the page, and portlets on the right side of the page. This can be thought of as 
a simple type of home page, and will be what you’ll see when content is migrated into the new 
templates from the old templates. 

The alternative setting on the ‘Display’ tab is for the ‘Teaser home page’, which is the home page 
design the new templates are been built for. In the delivered templates an institution (department, 
research group, project) home page has the following model, which does not allow for any text 
content: 
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This has been adopted by the Computing Service to create our home page 
(http://www.ucs.cam.ac.uk), which looks like this: 
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As you can see the page comprises of four columns: 

• the image takes three columns and the portlets on the right fill in the fourth column 
alongside. 

• under the image, the teasers take the left two columns, and can be positioned vertically or 
horizontally, with or without images. 

• the third column under the image can be used for a number of different portlets – one or 
several rss feeds, news, events, jobs or a teaser portlet (which is different from a teaser). If 
the third column is not used the teasers can spread across into it. 

• under the teasers (shown in the top example), you can add either further teasers or link 
boxes. 

• the site footer is built from four columns but they don’t all have to be filled. 
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How the teaser home page is controlled 
When you first switch your display to the teaser home page the screen you’ll get will be similar to 
this – in this example, becaue I have added a news item, the feed is showing on the right side of the 
holding image: 

 

The ‘Manage portlets’ screen for the Teaser home page allows you to add component portlets in 
various areas of the page, and looks like this: 
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What you can add 
You will need to prepare and upload the images you want to use on your home page – they need to 
be at the following sizes: 

• home page: carousel/large image - 885 x 432px;  

• teaser image - 250px square 

• teaser portlet: 349 x 125px 

Make sure you optimize the images so the files are as small as possible, especially if you are using a 
carousel containing several. If in doubt about sizing and optimizing images, please get in touch with 
falcon-support@ucs.cam.ac.uk for help. 

CAROUSEL 

To insert an image or images for the carousel, go to the pop-down and select ‘Carousel Image 
Portlet’: 

 

You will then see a screen like this: 

 

• browse to select the image you want to add 

• add a caption for the image if you want. It will be added on a 50px high black band 
overlaying the bottom of the the image. 

• Add image title (which will be shown when the pointer hovers over the image) and the alt 
text for the image. Either could contain the credit for the photo – the alt text ought to be 
descriptive for those who use a speaking browser. 
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• add either an internal or external link for the image – this is where the user will be taken if 
they click on it. 

When you save this configuration, you will see the item has been added under the Carousel section 
of the portlet screen: 

 

To add another  item, go to the pop-down menu again, so you build up a list of items. If you want to 
delete an item, click on the orange cross on the right of the line. You can deselect items for the 
carousel by clicking on ‘hide’ to rotate a selection, and you can reorder them. 

PORTLETS ON THE RIGHT 

When you select the 'Add portlet' pop-down list, the options available look like: 

 

This is the full list of portlets – some of these are also available in the third column or under the 
teasers. This is what they are all for: 

• Calendar portlet: Adds the standard Plone calendar. 

• Carousel portlet: This is still in the list because existing old-style carousels still work at the 
moment, but you can’t add new ones like this. Use the carousel at the top of the page. 

• Collection portlet: Collections are dealt with in a separate session. 

• Events: Along with separate but similar portlets for News and Jobs, this portlet collects the 
titles of Events and displays them as a list with a link to the full entries. If you add an Events 
portlet you can select how many items to display - you should leave the Workflow state as 
configured, unless you have special reasons to do otherwise. 

• Feedmixer and RSS Feed: These portlets are both for adding RSS feeds to your page. The 
first allows you to mix two or more RSS feeds together, while the second allows you to just 
insert one feed. When adding a Feedmixer portlet, since the links for the different feeds 
look the same, you need to be careful that you give the portlet an accurate title. Be aware 
that there may be quite long titles and displaying more than 4 or 5 items could take up quite 
a lot of space.  

 To add a single RSS feed portlet, the set-up screen is very similar but only a single rss feed 
can be added. Do be aware that this publishing system will not publish badly structured feeds 
- the Feedmixer portal will not work at all if one of the feeds is badly structured. 

 The RSS portlet has been set up to recognise RSS feeds from talks.cam and alter the footer 
text accordingly. Additional information is available about finding the URLs of RSS feeds is 
available at https://falcon-help.csx.cam.ac.uk/home-page/content/portlets/rss-urls 

• Link box: To create a link box you just need to add the URLs and link text to the portlet. The 
order of the links can be changed by moving lines up and down with the arrow icons. 
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• Quick upload portlet: Allows you to upload a batch of items into the current folder. Needs to 
be enabled for any folder requiring quick upload. There is more information about settings for 
the portlet at http://plone.org/products/collective.quickupload 

• Recent ploneboard conversations and Review list: These portlets will only work either if 
you are using ploneboard or if you are an admin user who moderates other user's submissions. 
They are included in the right-hand column but aren’t appropriate below the content. 

• Static text portlet: This is useful if you need to make a long-term announcement or add a 
block of text that refers elsewhere for full information. A static text portlet can be used to 
add just an image or to add an iframe. If you add an iframe into a static text portlet you need 
to paste the code while the wysiwyg editor is in ‘html mode’. 

• Teaser portlet: This can be used instead of a static text portlet as it is better formatted, 
with a specific size of image it expects. 

Because the portlets in the content area can only be added to the home page, you do not have to 
worry about the settings in the 'Block/unblock portlets' area of the page. When portlets are used in 
the right hand column these settings are important: if you don’t want inherited portlets to appear 
in a folder, select  Block against ‘Parent portlets:’ and then save the settings. Leave the ‘Group 
portlets:’ and ‘Content type portlets:’ settings as they are. 

TEASERS 

To add teasers to the home page, go to the pop-down and select ‘Teaser Portlet’: 

 

You will then see this configuration screen: 

 

The options are pretty self explanatory: 

• the heading, any accompanying image and the text 

• the choice to make the teaser horizontal or vertical 
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• the type allows you to add an icon if the teaser is for video or audio content 

• you can add a link to an internal item or an external url 

• you can replace the ‘Read more’ link with other text if it is more appropriate. 

As usual, you will need to save the item – you will then see that item listed under the teaser 
heading on the home page portlet management screen. When you have added some more, you can 
reorder them or hide some of them to rotate a selection. 

PORTLETS IN THE THIRD COLUMN 

If you want to add some portlets in the third column of the page, the choice is limited to the 
following: 

 

BELOW CONTENT PORTLETS 

If you want to add more portlets below the first tranche, the choice is again limited to either more 
teasers or link boxes: 

 

 

PRACTICAL 7:  

• At the home page, click on ‘Manage portlets’. You will see a list of portlets that are being 
shown (if there is any content to show) both on the right side and in the content area. Click back 
onto ‘Home’ in the navigation bar, or the site name in the breadcrumb trail.  

• Now go to ‘Display’ and select ‘Teaser Home Page’. At the home page, click on ‘Manage 
portlets’. You will see a far more extensive list of portlets that are being shown both on the right 
side and in the content area.  

• Under the Carousel heading at the top, use the pop-down to insert an image for the 
carousel – there is a suitable image in the images directory of your site.  

• On the right side, select RSS feed from the ‘Add portlet’ pop-down menu and add an rss 
feed of your choice – if stumped go to http://www.bbc.co.uk/news/ and copy the url of the rss 
feed there.  

• Insert at least one teaser, without inserting an image for it. In the third column below the 
large image, insert a teaser portlet, selecting the labeled image in the images folder. 

• Return to the home page to view the results. 



25 & 26 February 2013  30 

Day 2 
• Inheriting portlets and adding a footer 

• Adding more complex content to pages 

• Adding other content to your site – a research directory, discussion forums and forms 

• Adding users and groups, and restricting access to content 

• What metadata is and how to add it 

• Looking at the ‘back end’ of Falcon 

• Other admin functions 

7. Blocking portlets and adding a footer 
Blocking portlets 
The portlets shown on the right side of the home page will be inherited through all folders and 
pages unless this inheritance is blocked. Different portlets (or none) may be show on any page.  
Different portlets can be added even when portlets are being inherited, but inheriting portlets is an 
on/off function - if you want to keep only one of a group, you will need to block them all and 
manually add back the one you want to keep. 

If you don’t want inherited portlets to appear in the right-hand column of a folder, select  Block 
against ‘Parent portlets:’ and then save the settings. Leave the ‘Group portlets:’ and ‘Content type 
portlets:’ settings as they are. 

 

If you want to add different portlets and block inherited ones, add the new ones first, then block 
the inherited ones. If you don’t save the settings the blocking process will not occur. 

 

Setting the site footer and customising it for sections of the site  
The site footer is set on the home page, under manage portlets. There are two kinds of portlet that 
can be added, a Contact portlet and a link box. The contact portlet should be added by default, 
but if it isn’t then creating one will cause some default information to be added for privacy and 
cookie policies and a contact form. You should add the contact portlet in the left column. Link 
boxes can be added in any of the other three columns, linking to information of importance for your 
site. 

If you want to change footer information in any folder, go to the ‘Manage portlets’ link on the 
folder, block any of the parent portlets that you want to remove, and if necessary add new portlets 
for those columns. 

8. Adding more complex content to pages 
An earlier section described how to add simple content to pages – there is some content that you 
can add that requires a little more description: 

• using built-in styles 

• long pages can have a table of contents automatically added at the top 

• tables can be difficult to add effectively 

• video can be embedded 
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• iframes can be added in content 

• adding an image or carousel to a second level page. 

Using built-in styles 
The pop-down list in the editing bar gives you access to styles that you can add. The example below 
shows adding a style to an existing link, to add an icon. There is a variety of styles available, drawn 
from the University House style.  

 

 

Long pages 
If you have pages with a lot of content, broken up into sections with headings, you can format the 
page to automatically have a table of contents at the top. To do this, when you are editing the 
page, go to the 'Settings' tab at the top of the page and check the box next to 'Table of contents' 
and save. You will not see the table of contents in the 'edit' view of the page, only when viewing it. 

Tables 

Within the body text editing bar there is an icon for ‘insert table’  that, after you have 
specified number of rows and columns, inserts for you an adjustable table framework (if you add 
the class ‘standard’ to the table it will take the width of the column and be a grey grid). If you view 
the html version of the table you may see issues with the code you wish to fix, such as breaks being 
added. The ‘Advanced’ tab allows you to add a caption for the table, should you wish one. 

EXAMPLE TABLES 

With the class ‘bare’ applied to table: 

 

With class ‘standard’ applied to table: 

 

If you have a complex table that you want people to be able to use on a mobile device, you can use 
the style ‘vertical stacking table’ so they can read the table more easily: 
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Once you position your cursor into the content of the table, more controls appear in the editing bar 
to allow you to add and remove rows and columns and to add properties to rows or cells. You can 
add the style ‘tint row’ from the pop-down style list to add a tint.  

Once you have added the content, save the page. You are then taken to view the page, and if you 
are ready, you should publish it (select the right-hand 'state' tab and choose 'publish' from the pop-
down). If you wish to assemble the content in full before publishing it, you can publish the folder 
and contents later. 

If you have a complex table, it may be easier for you to assemble it in an html editor and then paste 
it into the html view of your editor window. 

Embedding video 
When you use Falcon we expect you to upload your video and audio to the streaming media service 
(http://sms.cam.ac.uk/) and then either link to it from Falcon or embed it in your web page.  

To embed an audio or video player from the SMS, first you need to go to the sms page the item is 
on, view the code of the page (usually View > Source in your browser) and select and copy the 
<iframe ...></iframe> code. In the editor window: 

• Go to the HTML view of the page, find the point where you want the video to appear and 
paste in the code you have copied. Make sure you are placing the video between paragraphs. 

<iframe width="480" scrolling="no" height="360" frameborder="0" allowfullscreen="" src=" 
http://sms.cam.ac.uk/default/smsMedia/embed/1346887?width=480&height=360"> 

The player will then appear on the web page, although you won’t see it in the edit view. Remember 
to add a link to the sms page (or page on other service) that features the video or audio as it gives 
access to a textual description and to alternative versions of the media (which people with poor 
connections or smartphones might need). 

On the page http://falcon-help.csx.cam.ac.uk/content/video there is a sample video so you can 
examine the code inserted, with a following line to add a link to other versions of the materials. 
View the source of the page to see the detail. 

To embed a YouTube video – see http://support.google.com/youtube/bin/answer.py?hl=en-
GB&answer=171780 for how to embed. Choose ‘Enable privacy-enhanced mode’ to ensure cookies 
aren’t being used. 

Embedding an iframe 
By default you can add an iframe into a static text portlet that appears in the right side of the page 
or below the content on the home page, and into the content of the page.  To insert the iframe 
code into a page: 

• Copy the iframe code from your source. In your editor, go into HTML mode and paste in the 
code where you want it to appear, the click ‘update’. In your editor window there may be a 
complaint that it won’t work, but when you save the page, the iframe will appear. 

CREATING IFRAMES TO FACEBOOK, TWITTER AND GOOGLE CALENDAR 

• In Facebook social plugins are added as iframes – see 
https://developers.facebook.com/docs/guides/web/#plugins for info about what you can do 
and how to do it.   
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• For Twitter you can only add buttons as iframes – see https://dev.twitter.com/docs/follow-
button and see https://dev.twitter.com/docs/tweet-button 

• For Google calendar, go to Settings and click on the calendar or calendars you want to use, 
then the iframe code you want is under 'Embedding this calendar' - it can be customised. 

Adding an image or carousel to a second level page. 
You can use the ‘Manage portlets’ link on a second level page or folder to add a large image or 
carousel to the top of the page. You do this in the same way as adding such an image to the home 
page, but you use an image of the smaller size (590 x 288px). 

PRACTICAL 8: 

• Go to your widgets folder and to the page where you added a link to the pdf file. Select the 
pdf file link and style it using the pop-down style for a Pdf link.  

• On another page in your widgets folder, add a table, with 3 columns and three rows, using 
class ‘standard’ for the table as a whole and add the style to tint the top row. 

• On another page in your widgets folder either  

 • embed a video from http://sms.cam.ac.uk/ (following the instructions above) 

 • embed an iframe, following the instructions above to allow it first, and use either 
an iframe of your choice or the iframe for the google calendar on the page 
http://www.cam.ac.uk/staffstudents/calendars/central.html (view the source of the page then 
copy it and paste it into your page). 
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9. Adding other content 
There are three main other types of content that you might want to add to Falcon 

• A research directory 

• Discussion forums 

• Forms 

A Research Directory 
Each instance of Falcon is created with a person-based directory (initially called Research Directory) 
in which people are put into categories (such as Faculty, Staff, Graduate students), cross linked in 
'specialties' (initially Research Themes) and could be linked with groups (initially called Institutions 
or Departments). People can also be linked to committees and collaborators. If the default 
directory is deleted, you can install a new one by going to ‘add new…’ > faculty-staff directory. 
Each site should only have one directory. 

Once categories have been created and people assigned to them, users can then view the people in 
the directory by way of research theme, staff type, department, etc. The cross linking can be 
created and edited either in the person's profile or in the category or group. 

Administrators setting up a research directory need to think about 

• The staff types you want for the people in the directory (known as classification) 

• The subject categories (initially Research Themes) that you want to put people in (known as 
specialties) 

• Whether you also want to put people in groups (initially called Institutions or Departments). 

• People can also be linked to a committee (which creates a group) and to collaborators. 

• Which of the many available fields in the Research Directory you want to use (the others can 
be ‘disappeared’ so tidying up the screen). The labeling on two of the options can also be 
changed. These adjustments are via the ZMI and are described on page 38. 

Note: If you decide to remove a category, you need to remove people from it first. 

Examples of directories may be found on these two Falcon sites (amongst others): 

• http://www.energy.cam.ac.uk/ 

• http://www.finance.group.cam.ac.uk/ 

**By default people in the directory become members of the site, which is why their profile must be 
created as crsid@cam.ac.uk - once you have started their profile by adding their crsid@cam.ac.uk 
and their name (and saved it), they will be able to log in themselves via their Raven credentials and 
fill in information, or the administrators can do it and ask them to correct the content. If you don’t 
use crsid@cam.ac.uk their profile will be available as part of the directory but they will be unable 
to log in and edit it.** 

The plugin we use is called ‘Faculty/Staff Directory’ and comes from Penn State University.  

RENAMING THE DIRECTORY  

To rename the directory: 

• Go to the home page of your site and click on the 'contents' tab on the editing bar. 

• Check the left-hand box next to the folder 'Research Directory' and click on the 'rename' 
button at the bottom of the table. 
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• Always retain the short name ‘directory’, but you can change the Title and click 'rename all' 

You will see the new name straight away in the navigation bar. 

ADDING AND CHANGING CATEGORIES FOR PEOPLE  

Users cannot add themselves to categories for their staff type, so the admin will have to do that. It 
can be done after they have edited their profiles - until they are added to a staff category then 
they won't appear in any list. By default the directory has three categories of member, shown in the 
left navigation at the top level of the directory - these are: 

• Faculty 

• Staff 

• Graduate Students 

The names of these categories can be changed, the categories can be removed and additional 
categories can be added. 

Each category page can contain text, images etc. and from the category page you can add members 
of the directory.  

In the ‘edit’ view, if you click on 'add' you will see a list of all members of the directory so you can 
choose the ones you want to add. If 'Graduate student' is selected in a person's profile as a category, 
they will automatically appear in this list. 

To change the name of or delete a category: 

• Go to the home page of your directory and click on the 'contents' tab on the editing bar. 

• Check the left-hand box next to the folder you wish to change - in this case 'Faculty' - to 
rename click on the 'rename' button at the bottom of the table. 

 

 

• Fill in the new Short Name and Title that you want and click 'rename all' (here it is fine to 
change the short name) 

• To delete, click on the 'delete' button at the bottom of the table – only delete a category 
after you have removed members from it. 
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To add a category: 

• Go to 'add new' in the editing bar and select 'classification' 

 

• Complete the Short Name and Title for the new classification and save. 

• You will see the new classification added at the bottom of the left-hand navigation.  

ADDING RESEARCH THEMES  

By default a directory has no research themes, so you will have to decide on what you want and 
then add them. The 'Research themes' link that appears in the navigation bar by default does not 
contain content of its own, instead it collects the information that you add to the research 
directory. If you prefer, you can rename 'Research themes', by following the instructions above but 
targetting the 'Research themes' directory - this will change the label for the navigation tab as well. 

Users cannot add themselves to research themes, so the admin will have to do that. It can be done 
after they have edited their profiles. The simplest way is to approach it from the research theme 
page, which, when you edit it, allows you to go through the list of people in the directory and add 
them. 

To add a new research theme: 

• Navigate into the 'Research themes' folder from the left hand navigation of the research 
directory 

• Go to 'Add new…’ > ‘specialty' in the editing bar 

• Complete the Short Name and Title for the new specialty and save. You can add other 
information - text, images, links, etc. and also link to people in the directory, but at this 
stage you might not want to. 

• You will see the new specialty added as a sub-list in the left-hand navigation. 

• Note: when you create and save a new research theme, you will end up in it. Make sure you 
move back up a level to the top level of the 'Research themes' folder before you add another 
specialty otherwise your next addition will be a sub-specialty. 

ADDING A DEPARTMENT/INSTITUTION OR COLLEGE LIST  

In a similar way to adding research themes, you can add a list of departments/institutions or 
colleges so members of the directory can be grouped in that way.  

The folder you need to use is already prepared for you at the top level of the site - go to ‘contents’ 
view to access the folder ‘Departments’, as by default it is not displayed in the navigation bar. You 
can change the name (as for categories), if you wish. 

To add a new entry: 

• Go to 'Add new…’ > ‘institution' in the editing bar 

• Complete the Short Name and Title for the new entry and save. You can add other 
information - text, images, links, etc. and also link to people in the directory, but at this 
stage you might not want to. 

• You will see the new entry added as a sub-list in the left-hand navigation. 
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ADDING PEOPLE TO THE RESEARCH DIRECTORY  

Before an administrator starts adding people to the directory on their site, it is worth setting up a 
test profile both for the practice and to decide which fields you want people to fill in. In order to 
meet the needs of most sites there are many fields available, and while it is not possible to re-label 
fields, it is quite easy to remove fields from view. Once the administrator has considered what 
information they wish to present, they can do this and the process of completing the profiles in the 
way you'd like to see them will become easier (how to do this will be covered later). 

NB: If you are adding to the directory someone who is already a manager or member of the site, 
don’t enter anything in the ‘Access Account ID’ field. 

To add a person to the directory: 

• Go to ‘add new...’ in the editing bar and select ‘person’ 

When starting a person profile you get the following screen: 

 

Complete the ‘Access Account ID’ with their crsid@cam.ac.uk so they can Raven authenticate to the 
site and fill in their details, and you must also add their first and last names. If you don’t enter a 
short Name, this will be exposed in the URL. 

CHANGING VIEWS FOR LISTS OF PEOPLE  



25 & 26 February 2013  38 

Once you have people in your research directory you can explore the different ways you can display 
the list when you view the people in a research theme, a classification, department etc. We 
recommend that if you have many people in a list you use a display that doesn't show their images, 
as it increases the load time for the page. 

The view in use may be changed by going to the 'display' pop-down list in the editing bar. 

Main view of a directory 

For the main view of the whole directory, such as http://www.finance.group.cam.ac.uk/directory 
use the display style 'tabular view', which the members of the directory listed in a table and adds 
the categories across the top, like this: 

 

or 'A-Z view', which adds an index across the top, like this: 

 

Viewing subsets of a directory 

For viewing shorter lists of members, you can also use 'gallery view' (shown at 
https://www.energy.cam.ac.uk/directory/research-staff, for instance), which shows you any 
images that have been added to person profiles, all sized to 100px wide. If you want all pictures to 
look the same size then their proportions need to be the same so the scaling to 100px wide makes 
them uniform. 

ADDING COMMITTEES  

To add committees to the options available for categorising people, go 
to /directory/committees/folder_contents in your site (at 'Research directory' go to the contents 
tab on the editing bar and locate the 'Committees' folder - which will be unpublished). Publish the 
folder, then click on it and on the editing bar choose, 'add committee'. 

Fill in the details about the new committee - at this point you can choose people from the directory 
who ought to be in the committee. If you go into a profile in the research directory, in the editing 
screen [Professional information] you can choose committees to which they ought to be added. 
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PRACTICAL 9:  

People who are working on a site as a pair will have to work together to do this practical, as there 
can only be one Research Directory on a site. 

• Go to the home level of your website and add the research directory back to the navigation 
bar (you need to publish it). 

• Your site is a research initiative for ‘Feline studies’ across the University. Follow the 
instructions on the pages in http://falcon-help.csx.cam.ac.uk/research-directory to do the 
following: 

 • Change the name of the Research Directory to ‘People’ 

 • Change the existing users categories to ‘Staff’, ‘Students’ and ‘Visitors’ 

 • Add three research themes (be creative) 

 • Add two or three institutions who contribute to feline studies and re-order them 
alphabetically 

 • Add a person (one of your neighbours, not anyone who is already an admin of the 
site) and add them as staff, contributing to two of the research themes and associated with one of 
the institutions. Save the profile. 

 • Ask your neighbour to log into their profile and add some more information about 
themselves. 

• Now go to the home level of your website and add the research themes back to the 
navigation bar (go to the folder, then via the ‘edit’ tab to ‘Settings’). The research themes content 
is a collection, and it should now show a list of the three research themes that you just added in 
the research directory. 

Discussion forums/message boards 
You can add as many discussion forums into a Falcon site as you like – adding them is very 
straightforward, via the ‘add new…’ tab and selecting ‘message board’. The plug-in we use for this 
functionality is called Ploneboard. 

Forms 
Falcon uses a plugin called PloneFormGen to generate fairly simple forms through the web. With it 
you can build simple, one-of-a-kind, web forms that save or mail form input, which you can then 
build on to allow uploads and to collect spreadsheets of information that you can download. 

When you create a new form folder (by going to ‘add new…’ > ‘form folder’), by default it will use 
a mailer action adapter – the way to work with your first form is to create a new default form and 
then adjust it afterwards. Once you have a saved form, you can view the structure by clicking on 
the ‘quickedit’ tab on the editing bar, and add new elements by selecting them from the ‘add 
new…’ menu shown below. The toolbox on the right side of the form gives you more information 
about what the different elements are. 
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PRACTICAL 10: 

Either 

• At the top level of your site add a new discussion forum and 
configure it for discussion of feline studies, with a group for eye 
problems 

or 

People who are working on a site as a pair will have to work together to do 
this practical, as there can only be one default contact form. You could 
work separately just to create a default form each. 

• Create a form for your contact information for the site (see page 18 
for what you need to name it to ensure it is used as the default). If you 
like, you can extend the form by working through the tutorial at 
http://groundwire.org/resources/articles/plone-form-gen or 
http://learnplone.org/documentation/tutorial/creating-forms-with-plone/ 
or by using the handout for Plone Forms training 

 

 

10. Adding users and groups, and restricting access to content 
There are many different 'levels' of users within Falcon, as shown below (this is the standard set, in 
Falcon there are some additional roles that have been added by Faculty Staff Directory). Most 
commonly seen are 'members' and 'managers'. At the time the site is set up managers are configured 
in, but more can be added by an existing manager, who can also add members to the site. 

Remember that if you are adding a research directory, everyone with a profile will become a 
member of the site and will not need to be added using the method below. 

• Contributor - a user with a contributor role can add content and submit it for review. Such 
user can also view another user's content that is not in the published state, but cannot edit it. 

• Editor - a user with an editor role can edit content by self or others. He can't add new 
content, but can edit existing content. Such user can manage content properties and submit 
content for publication.  

• Member - this is the most common role for site users. Users with this role can see anything 
that is published on site, but cannot add new content or edit it. This role is assigned to 
normal users who join the site but will not be doing any changes to the content.  

• Personnel Manager – this is a category added by the research directory to manager other 
people’s profiles. 

• Reader - users with a reader role can read content by others, they can view content items 
that are in a private state, but cannot make any changes.  

• Reviewer - a user with a content reviewer role has the power to edit/publish content that 
has been submitted for review, but cannot create new content. There is a special portlet for 
Reviewer that gather content that needs to be reviewed.  

• Site Administrator - a site administrator has super user powers within Plone site. Such user 
has full access to manage content and configuration in a Plone site, but does not have access 
to ZMI and other places, where system administration or Plone integrator/developer skills are 
required. 
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• Manager - a user with a manager role can do everything. Such user has access to the control 
panel, where many site wide settings can be changed and updated. Manager can also manage 
things via the Zope Management Interface. 

Adding users and administrators 
• A current admin user of the site must log in to it and go to 'Set Setup' (in the top right corner 

of the browser window). 

• Select 'Users and Groups' and select 'add new user' 

• Enter their name and the username, which needs to be in the form crsid@cam.ac.uk. If a 
user normally uses an @cam email address then it will be the same, if not you can use Lookup 
(http://www.lookup.cam.ac.uk/) to find what their crsid is. You will also need to add their 
email address. Click 'register'. 

• On the 'User overview' page you have been returned to, the user you have just added will 
have been added as a member for the site. If you wish them to be an admin user, tick the box 
under ‘manager’ and then 'apply changes' at the bottom of the table. 

NOTES 

Admin users who have been added as part of the setup procedure will not show as members of the 
site, just as admins.  

If your site is registered with the UK Federation, when crsid@cam.ac.uk is mentioned, for non-
Cambridge users this may be, for instance, <ProtectNetwork UserID>@idp.protectnetwork.org. You 
will need to find out from non-Cambridge users what their Shibboleth id is. 

Adding groups and adding users to them 
For easier users roles management, users with identical roles can be grouped. Certain roles are 
assigned to a group, and then, whenever you want to give someone certain permissions, you can 
add that user to that group. The users in a research directory are automatically allocated to groups 
corresponding with the categories to which they are assigned. 

A special virtual group exists in your Falcon site for 'Cambridge users', which consists of all Raven 
authenticated users. You can use this group for setting up 'Cambridge-only' access to folders  or to 
the whole site (for more information see https://falcon-help.csx.cam.ac.uk/site-setup/raven-whole 
and https://falcon-help.csx.cam.ac.uk/site-setup/raven-part). You will see other groups listed, 
some of which will have been created by the system and others by the categories in your research 
directory. 

TO CREATE A GROUP  

• A current admin user of the site must log in to it and go to 'Set Setup' (in the top right corner 
of the browser window). 

• Select 'Users and Groups', select 'groups' from the tab bar, and on the next screen select 'add 
new group'.  

• Once you have named and saved your group you can assign users to it. Users can be assigned 
to any number of groups. You need to have added your users before you can add them to the 
group! 
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PRACTICAL 11: 

People who are working on a site as a pair will have to work together to do this practical. 

• Talk to your neighbours in class, find out what their crsid is and add them as an 
administrator of your site. Check that you can log in to another site for which you have been added. 

Making a folder Cambridge-only accessible 
You may wish to make one or two folders on your site accessible only to Cambridge users - here's 
how to do it: 

• At the top level of your site, create a folder and in it your content, leaving it all private 
rather than publishing it 

• Go to the top level of the folder for which you want to change the access and in the editing 
bar click on the 'Sharing' tab. 

• If you have chosen a default page for the folder, you will see the following at the top of the 
Sharing page - if you do, follow the link to change the settings for the whole folder. 

 

• Search for 'Cambridge users', and tick the box 'Can view'. 

 

• Save this setting. Since this setting has been done on the folder and is set to be inherited, all 
sub-folders and pages will assume similar settings, which will be shown by a white and green 
tick. 

To make the folder visible in the navigation bar, go to the top level of the site and go to the 
contents tab in the editing bar. 

• Check the box to the left of the folder you wish to change and click on 'Change state' 

• On the following screen, ensure you do not have a tick by 'Include contained items ' and then 
select 'Publish' from the option at the bottom of the page and save. 

The item will now be in the navigation bar but when users check on it they will have to give their 
Raven details to access the content. 

You can use the same technique to make the folder viewable by another group of users or just by an 
individual – the restricted content must be left unpublished for the effect to work. 

Making a folder or page editable by an individual or a group 
You can make pages editable by an individual or group by following the same steps as those above, 
except that the content should be published.  

Once pages have been published, you can make them editable by a member of the site who doesn’t 
have admin rights. To do this, first you publish the pages, then: 

• Go to the top level of the folder for which you want to change the access and in the editing 
bar click on the 'Sharing' tab. 
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• If you have chosen a default page for the folder, you will see the following at the top of the 
Sharing page - if you do, follow the link to change the settings for the whole folder. 

 

• Search for the name of your user or group, and tick the box 'can edit', which will allow them 
to edit existing pages If you tick the box ‘can add’ then they will be able to add pages as 
well. They won’t be able to delete pages. 

PRACTICAL 12: 

People who are working on a site as a pair will have to work together to do this practical. 

• In the last practical you added a neighbour as an administrator of your site. Go back to the 
users setup page and change their permissions from a user to a member. 

• Go to a page in your widgets folder and give that member editing rights to that page, then 
tell them what page it is so they can go and edit it.  

Adding users from outside Cambridge 
Falcon sites use Raven-Shibboleth authentication, which is why you are registered using 
crsid@cam.ac.uk as your username. If we register your site with the UK Federation it may be used 
for full Shibboleth authentication so people from other institutions with Shibboleth IDs can become 
members of the site. To gain UK Federation registration, email falcon-support@ucs.cam.ac.uk. 

If you wish to add members to your site who do not belong to an organisation that can provide 
Shibboleth IDs, they can obtain a third-party Shibboleth ID from http://protectnetwork.org/. Tell 
falcon-support@ucs.cam.ac.uk, so we can register your site with ProtectNetwork, and send us their 
email addresses so they can be added as users for the site. 

To make them a member of your Falcon site, you must add them either by making an entry in the 
Research Directory or by adding them under Site setup > Users and Groups - in both cases you use 
their ID in the form 

<ProtectNetwork UserID>@idp.protectnetwork.org 

If you add the user via the Research Directory they will automatically become a member of the site 
If not, you will have to add them via Site setup > Users and Groups.  

For technical reasons we prefer to register sites with the UK Federation with their final URL rather 
than the development URL (in the form http://www-falcon.csx.cam.ac.uk/site/CSTEST), which 
means that you can only allow non-Raven Shibboleth users access to your site when your final URL 
has been decided and put in place. For those transferring an exisiting URL to a Falcon site, this 
means that non-Raven Shibboleth users can only be given access after the site has gone live, 
although the preparatory work of gaining an ID and adding them as members can be done ahead of 
time. 

Once you have a site registered with the UK Federation, your site will display two options for log-in 
in the grey bar on the top right: 

 

 

LOGGING IN TO A SHIBBOLETH AUTHENTICATED SITE 

When you log into a Shibboleth-protected site, you will first see options to ‘log in using Raven’ or 
‘log in using UK Federation’ (as above). When a user opts to log in with Shibboleth, they will see the 
UK Federation login screen.  You will need to either select your home organisation from the (long) 
pop-down list or search by keyword to find it, and then select it. Both University of Cambridge and 
ProtectNetwork are in the list of options. Once you have selected your home organisation, their 
authentication screen will be displayed and you will log in as usual. You can see the UK Federation 
log in screen at http://falcon-scratch.csx.cam.ac.uk/ 
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11. What metadata is and how to add it 
Metadata is information about a page that is used by search engine indexers to gain information 
about the page. In Falcon you can (and should think of) adding metadata to pages and pdf files, 
particularly those that have complex content that people may search for with a wide variety of 
search terms - you can add keywords to the metadata that will cause the page to be found even 
though those words aren't in the text of the page. We use a third-party plug-in to add metadata and 
as a result it’s not possible to add metadata to all pages – entries, categories and research themes 
in the Research Directory; events; collections; forms; are all excluded because of cross-
functionality issues. 

Even if you aren't going to add metadata on all pages, you should do so for your home page. When 
on your page, select the 'seo properties' tab on the editing bar. This will take you to a long screen 
with extensive opportunities to 

• Override or change the title tag 

• Add a meta description tag 

• Add a meta keywords tag 

• Add an HTML comment to the page 

• Add a robot tag 

• Add a distribution tag, a canonical URL or custom meta tags 

Of these, you should add meta description and keywords tags to every page, and in some 
circumstances it might be useful for you to have a different title tag to the h1 heading used on the 
page (which is the default position). Note that by default the site title is added after the title tag, 
and once you ad an override it no longer is. To do this, check the 'Override' box by the term you 
want to change and add the term or terms in the text box below. There are adequate instructions 
on the page. Remember to save your changes when you have finished. 

Collections – what they are and how you can use them  
This will be the subject for a special session in April (see http://training.csx.cam.ac.uk/event/ 
458772) 

12. Looking at the ‘backend’ of Falcon 
For a few of the practical exercises you have adjusted settings by going into ‘Site Setup’. This gives 
you access to much of the functionality you’ll need as an admin of the site. Many of the settings 
available, if changed, would break your site quite easily, so you must be careful what you tinker 
with. Only change settings when you have instructions giving details of what to do - check 
beforehand with falcon-support@ucs.cam.ac.uk if you are unsure. 

In the Site Setup screen there is an entry into another world, which is even more fraught with 
possibilities to break your site. The Zope Management Interface (ZMI) gives entry into the code at 
the back of the site: 
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Before you go into the ZMI to do anything you need to be sure of what you’re doing.  

Undo 
The ‘Undo’ function, which allows you to undo any number of changes 

• Go to Site Setup > ZMI and click on the ‘Undo’ tab at the top of the screen. You can select 
and undo any number of steps all at once. Be aware that if you choose to undo a step since 
which other steps have taken place, there may be interactions that will cause unexpected 
results. Compare this with the ‘History’ function shown below. 

To get back out of the ZMI, go to the root level (shown at the top of the page as /) and then click 
on the ‘View’ tab. 
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Exposing and hiding fields and changing (some) field titles in the 
Research Directory 
When you first get your Falcon site some of the fields in the Research Directory aren't showing. To 
make them all visible, before deciding which you want to use, you will need to venture into the 
Zope Management Interface. If you aren't comfortable doing this, email falcon-
support@ucs.cam.ac.uk asking for help. 

To find the configuration panel: 

• Go to 'Site setup' > 'Zope Management Interface' 

• Scroll down to and click on portal_properties (sitename) 

• click on falcon_fsd_properties (Falcon FSD Properties) 

You will see a screen that looks similar to this: 

 

• Run down the check boxes and check all of those that are unchecked. If you want to change 
the titles for the titles shown then you can do that. 

• Click on 'Save Changes' 

• Don't add any new properties. 

To get back to your site pages: 

• Click on the first '/' in the top line of the page 

• Click on the 'View' tab 
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13. Other admin functions 
There are several functions available to site administrators to help them with tasks: 

• Using the ‘History’ function on pages to track changes 

• Setting Content rules 

• Using keyword manager for your Research Directory 

• Add redirections and aliases 

• Changing workflows 

• Adding Google analytics code to the site 

* Adding a robots.txt file to the site 

Using the ‘History’ function on pages to track changes 
For any page, admins for the site will see a link marked ‘History’ below the editing bar: 

 

When you access this you will see a list of all the changed versions of the page, when they 
happened and who did them, with opportunities to view them, compare them with the current 
version, and revert to that version: 

 

Setting content rules 
• You can set up content rules to automatically perform an action when certain events (known 

as "triggers") take place. For example, you can set up a content rule to send an email (the 
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action) whenever certain (or any) content is added to a specific folder (the trigger). Some 
other examples of what content rules can do are 

 • Move content from one folder to another when that content item is published 

 • Send email when a content item is deleted 

 • Delete content after a certain date 

 As an example, for one Falcon site the admins get an email when any member edits their 
profile in the research directory. 

 For a full tutorial see http://plone.org/documentation/kb/using-content-rules/tutorial-all-
pages 

Adding Google analytics code 
• First register with Google analytics (http://www.google.com/analytics) and acquire a site 

code  

• Go to Site Setup (in grey bar)  

• Go to Plone configuration > Site, which shows you possible site-wide settings 

• Go to the section 'JavaScript for web statistics support' and paste in the Google analytics 
code. Other code you might need to add for analytics or site analysis can be pasted into this 
box as well, but make sure you find out if it is sensitive to the order in which it appears.  

There will be a 24-hour lag before your data starts appearing on the Google analytics reports. If you 
are transferring your site to a pre-existing site name, you can just copy and paste the same 
analytics code and your reports will carry on without a break. 

Adding a robots.txt file to the site 
By default the site has a blank robots.txt file – to modify it you need to do the following: 

• Go to ‘Site setup’ > Zope Management Interface > portal_skins > plone_templates and click on 
robots.txt 

• Click on the ‘Customize’ button 

•  You can now customize that file. As you see at the top of the page, the location for the 
editable file is /portal_skins/custom/robots.txt 

• Remember to save changes. To get back to site pages, either edit the URL or click on the first 
‘/’ of the path at the top of the page and select the ‘View’ tab. 

Other functions 
• If you have an extensive Research Directory and need to manage keywords, ask falcon-support 

for advice.  

• If you are moving a site to Falcon and need to add redirections. 

• If you need a different workflow for your site we can also help with this. 

If there are additional functions you need or want, please ask and we will see if there is a suitable 
way of adding it. 
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The future 
Existing sites will be converted into the new templates, on request, from 4 March. New sites have 
started using the new templates from 20 February. The new templates use Plone 4.2, which 
introduces some changes: 

• A change in how the home page functionality works, introducing the new picture carousel 
and ‘teasers’ 

• A change in how the navigation bar works – it now includes pop-downs to show the second 
level of navigation 

• Improvement in how to add links in portlets 

• A change in how you add users to a site 

More help to current users will be available. 

 Further information 
• http://falcon-help.csx.cam.ac.uk/ 

• This course runs almost every month, with information at 
http://training.csx.cam.ac.uk/course/ucs-falcon There is a new series called ‘Falcon: 
Further Topics’, which runs for half a day.  

• Falcon user group wiki, accessed at https://wiki.cam.ac.uk/websupport/Falcon-users-group  

• A User’s Guide to Plone 4 – available as a pdf/e-book from 
http://www.enfoldsystems.com/support/a-users-guide-to-plone.html 

• Plone 4 documentation at http://plone.org/documentation – always check that what you are 
looking at applies to Plone 4 and not to earlier versions. 

• There are various books available but most are from previous versions of Plone and will not 
apply to Falcon. 


